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AB222-3 Doug’s Quik Tips is a regular and popular part of the AU Quarterly Newsletter.  In this 
session, Doug will cover many different quick topics on various functions available in AutoCAD 
Architecture.  There are a lot of little nuggets of information inside the software that can make a user 
more productive, if the user just learns of them.  This fast-paced class is focused on covering so many 
different quick tips that every user should be able to pick up something to help them in their job.  While 
this class is focused on AutoCAD Architecture, many of the tips are also applicable to AutoCAD and 
AutoCAD MEP. 
 

 

 

 

 

 

 

 

 

About the Speaker: 
Doug is a design software consultant to the AEC community, a Certified AutoCAD Architecture 
Professional, a Certified Revit Architecture Professional, and the AEC Technical Editor for the AU 
Quarterly Newsletter. He was formerly a VAR Senior Consultant, providing education and 
implementation services for AutoCAD® Architecture, Revit® and AutoCAD®. He is a repeat speaker at 
Autodesk University, AUGI CAD Camps, and an ATC instructor. For over 20 years, he has been 
managing and/or consulting with Autodesk products, including over seven years as the Director of CAD 
Technologies for a 240-seat architectural firm. He has also been a Cadence magazine Top Dog winner 
and an AUGI CAD Camp Top Dawg. 
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1.  Mtext Default Text Display 
You can change the default text in the Mtext editor to be something 
other than “abc”.  Type  MTJIGSTRING to change the text string 
displayed in Mtext.  Limit is 10 characters and it is a system variable 
so it will stay that way for you on that computer until you change it. 
 

2. Eliminating Problems with Different Z Values 
If you are getting the “Lines are non coplanar” message when filleting lines or having other 
issues associated with the “Z” elevations of entities, there is a way to help prevent the problem.  
Set the OSNAPZ variable to “1” and the “Z” value for any point entered thereafter will default to 
the current elevation shown in the drawing status bar.  This variable can also be toggled by 
picking the Z icon in the drawing status bar or going to the Drafting tab in Options and placing 
a checkmark next to “Replace Z value with current elevation”. 
 

3. Annoying Tracking Vectors with Otrack 
Are you like me and get annoyed with all of those dotted tracking 
vector lines that start  appearing all over the drawing when having 
the OTRACK feature turned on?  (That is the Otrack button on the 
status bar.)  If so, you probably ended up just turning Otrack off and 
then forget to turn it on when it is handy to use.  A better option is to 
go into the Options dialog box, go to the Drafting tab, and set the 
Alignment Point Acquisition setting to “Shift to Acquire” instead of the default “Automatic” 
setting.  Now you can have Otrack turned on all of the time and you won’t get those tracking 
lines except when you want them.  When you want them, just hold your cursor over the desired 
tracking point (such as an endpoint) and tap the Shift key.  You will then see the tracking line for 
just that one point that you select. 
 

4. Alternate between Trim and Extend 
Pressing the Shift key temporarily changes the Trim command to be Extend and vice versa.  
This is handy when you want to modify several entities and don’t want to reselect the entities in 
between the commands.  Just start either of the 2 commands and hold down the Shift key to 
make it do the other function without exiting the command. 
 

5. Fillet with Zero Radius 
Do you find yourself bouncing back and forth between a fillet radius of zero and another value?  
You can hold down on the Shift key when using the Fillet (and Chamfer) command to get a 
temporary radius of zero.  This allows you to have your desired non-zero setting and use the 
Shift key at any time to get a zero radius. 
 

6. Closed Polyline Around Interior of Entities 
The little known Boundary (or Bpoly) command (default keyboard shortcut 
of BO) is great for creating a closed polyline around the interior edge of 
entities.  If you have an area that is fully enclosed, this command will give 
you a polyline around the perimeter of the space and on top of whatever 
entities enclose the area. 
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7. Quick Polyline Around Building 
We often want to get a boundary polyline around the exterior of a 
building to get a footprint for area takeoff or other reasons.  Go to 
the Basics palette of the Detailing Palette Group and pick on the 
Shrinkwrap tool at the bottom of the palette.  You can then select 
the entities in the drawing that you want a polyline around.  If you 
switch to a Reflected display configuration first, you won’t have the 
exterior door swings or window sills affect the polyline. 
 

8. Dashed Polylines with Vertices 
Do you want dashed type lines to be continuous through 
(and seem to ignore) the vertices of a new polyline?  Type 
PLINEGEN and set the drawing specific variable to 1.  To 
change existing polylines, highlight the polyline, go to the 
Properties palette and change the Linetype Generation 
option under the Misc section from Disabled to Enabled. 
 

9. Polyline Conversion Question 
When you use the PEDIT command to convert a line to a polyline, do you get tired of answering 
“Yes” to the “Do you want to turn it into one” question?  If so, type PEDITACCEPT at the 
command line and change the variable setting to 1.  This will eliminate this question and since it 
is a system setting, it will stay set this way until the user changes it. 
 

10. Adding Folder to Places 
When you are in the Open dialog box, you can add your favorite folders to 
the Places list on the left side of the dialog box.  Simply select the desired 
folder and drag it over to the Places list.  Right-click on that new icon and 
choose the Properties… option to change the name of the shortcut.  
Remove it when you are done with it. 
 

11. Frame Around Images 
Images that are brought into AutoCAD must have the rectangular frame around it be displayed if 
you want to modify the image.  Since you usually do not want the rectangle to print, you turn it 
off.  The IMAGEFRAME variable that controls image frame visibility now has 3 options.  A 
setting of 0 turns off the rectangle so that it does not print.  A setting of 1 displays the rectangle 
and prints it.  A great new setting of 2 displays the rectangle so you can manipulate the image, 
but does NOT print the rectangle.  This is also on the Reference panel of the Insert menu. 
 

12. See Layers for Only a Specific Xref 
It can occasionally be helpful to see just the layers for a 
specific xref in the Layer Manager.  Open the Layer 
Manager and in the left Filters pane expand the All filter, 
expand the filter named Xref, then select the name of the 
xref for which layers you desire to see. 
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13. Highlight Layers in Layer Manager that have Viewport Color Overrides 
Since it is not readily evident as to what layers have their color 
overridden in individual viewports, you can set a background 
color to be shown in the Layer Manager for each layer that has 
the color overridden.  In the Layer Manager, select the 
Settings… button at the bottom.  At the bottom of the Layer 
Settings dialog box, change the color as desired in the 
Viewport override background color box.  
 

14. No Xref Layers in Layer Manager 
When working with drawings with many xrefs or xrefs with many layers, 
the Layer Manager can  be difficult to locate your desired layer due to 
so many layers being displayed.  You can make your Layer Manager 
display only layers that exist in the host drawing.  Open the Layer 
Manager and in the left Filters pane expand the All filter, then select 
the filter named Xref.  Now place a checkmark next to the Invert Filter 
option at the bottom of the Layer Manager. 
 

15. No Xref Layers in Layer Dropdown List 
When working with drawings with a lot of xref layers, the host drawing layer you desire to use 
may be difficult to locate in the layer dropdown box.  You can make your layer dropdown box 
display only layers that exist in the host drawing.  Open the Layer Manager and in the left 
Filters pane expand the All filter, then select the filter named Xref.  Place a checkmark next to 
the Invert Filter option at the bottom of the Layer Manager 
and pick the Settings… button.  In the Layer Settings 
dialog box, go toward the bottom and place a checkmark 
next to the “Apply layer filter to layer toolbar”.  
 

16. Dim a Locked Layer 
It is often nice to have it be very obvious when a layer in the drawing is locked so you know 
what will or will not be modified with commands.  You can have 
all locked layers display as a faded version of their assigned 
color.  Open the Layer Manager and select the Settings… 
button at the bottom.  Go to the middle of the Layer Settings 
dialog box and pick the Lock and fade radio button option.  
Pick on the Locked Layer button below that radio button to make sure that the “Locked Layer 
Fading” text is darker and then move the slider bar to the desired percentage of fading.  
 

17. Getting the Layer Listing to Alphabetize 
Occasionally your layers do not display in alphabetical order in your Layer Manager or layer 
dropdown list.  This can be corrected by issuing the MAXSORT command and setting the 
number to a value higher than the number of combined layers in the drawing.  The default value 
is 1000. 
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18. Control Layers Separately for Multiple Copies of Same Xref in Drawing 
When working with a host drawing that has multiple copies of the same xref (such as a hotel or 
apartment building), it is sometimes desirable to be able to control the layer visibility of individual 
instances of xrefs.  This can be done by xreferencing the file into the host multiple times and 
giving each instance its own name in the Reference Name box at the box of the External 
References palette. The Reference Name must be changed after xreferencing it in and before 
the next drawing is xreferenced. 
 

19. Clip the Inside Portion of an Xref 
Many times it is desirable to make a blank area or hole inside 
the displayed xref, and you can use the clip command to do 
this.  Highlight the desired xref to clip, right-click, and select 
Clip Xref from the context menu.  At the “Enter clipping 
option:” prompt, select New.  At the “Specify clipping boundary 
or select invert option:” prompt, type “I” for the Invert option.  At 
the “Specify clipping boundary or select invert option:”, choose 
your desired method of specifying the boundary.  
 

20. Xref Display Configuration Different than Host 
Sometimes it is beneficial to have the Display 
Configuration of an xref be different than the Display 
Configuration that is set in the host drawing.  Highlight 
the xref, right-click, and select Edit Object Display 
from the context menu.  Go to the Xref Display tab 
and place a check next to the “Override the display 
configuration set in the host drawing” option.  Select 
the desired Display Configuration from the list.  
 

21. Draw Curved Walls 
Placing curved walls in ACA can be a bit of a pain sometimes to get them just like you want.  I 
find it to draw circles or arcs to get the desired radius, center point, etc that I want for the wall 
and then convert those to the actual wall.  After drawing the linework, go to a palette containing 
the desired wall style (or a similar wall style), right-click on the wall tool, then select “Apply Tool 
Properties to -> Linework”.  This will create a wall with the justification line of the wall at the 
location of the arc or circle. 
 

22. Quickly Draw Remaining Two Walls of Building 
When drawing a building with several sides, there is an easy 
way to finish off that last corner of the building and make sure 
that it is a 90 degree corner and lines up with the start point of 
the first wall drawn.  When ready to draw those last 2 walls, 
right-click and select Ortho close from the context menu.  
Point your cursor in the general direction of the remaining 
building corner and pick.  Your last 2 walls will be drawn with a 
90 degree corner.  
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23. See Wall Graph Lines to Aid Wall Cleanups 
AutoCAD Architecture walls clean up with each other based upon the graph 
line of each wall.  Those wall graph lines are turned off by default and it is 
easier to know how to get walls to clean up when the graph lines are 
displayed.  To turn on all wall graph lines in a drawing, highlight a wall, right-
click, and select Cleanups, then select Toggle Wall Justification Display. 
 

24. Create Keyboard Shortcut for Toggle Wall Graph Display 
Since wall graph lines control the wall clean up, it is handy to have an easy way to toggle the 
display of the graph lines.  Add a keyboard shortcut, such as WT, as use the command 
WallJustificationDisplayToggle. 
 

25. Graphically Set Cleanup Radius for Walls 
Walls that have the graph lines at locations that don’t allow them 
to clean up automatically usually need to have the cleanup radius 
adjusted.  This is easiest done by toggling on the graph line 
display, then selecting the arrow grip which is at a 45 degree 
angle to the end of the wall needing the cleanup radius modified.  
Move the arrow grip so that the displayed cleanup circle overlaps 
the graph line of the adjacent wall.  
 

26. Wall Automatically Snaps to Another Wall 
Walls can automatically snap to the graphline of 
another wall when you pick a point near that wall.  
This feature aids in the cleanup of walls when using 
a cleanup radius set to zero.  Go into the Options 
dialog box, go to the AEC Object Settings tab, 
then look in the Wall Settings area.  The “Autosnap New Wall Baselines” option affects only 
new walls that you are placing.  The “Autosnap Grip Edited Wall Baselines” option affects 
walls that you are grip-editing to move the wall endpoint.  (I like to not have this option selected 
so that I can extend a wall out for stub wall situations.)  The “Autosnap Radius” setting is the 
maximum distance for snapping to the wall and works with either of the above settings.  For 
example, if the setting is set to 6”, any time you pick a point within 6” of the adjacent wall’s 
graphline, the wall you are working with will automatically snap to the graphline of the other wall.  
Note that the wall’s graphline is the key and not just any wall edge.  This is a drawing-specific 
setting, so you may want to set this in your template drawings.  
 

27. Lengthen Wall at Constant Angle 
When lengthening a wall at an angle, it is easy to grab the 
square grip at the end of the wall to adjust the length, but then 
the wall usually ends up at a different angle.  This is easily resolved by adjusting the length of 
the wall by using the arrow grip at the end of the wall as it only adjusts the wall endpoint along 
the same angle. 
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28. Snap to Wall Components 
Are you having trouble snapping to any part of a Wall object except the justification line?  If so, 
go into Drafting Settings, go to the Object Snap tab, and remove the checkmark next to “Allow 
general object snap settings to act upon wall justification line”.  
 
 
 
 
 
 

29. Snap to Block Components 
Are you having trouble snapping to locations within a block?  If so, go into the 
Options dialog box and go to the AEC Editor tab.  Remove the checkmark 
next to the option labeled “Object Snap” under “Optimize for Speed”. 
 

30. Visual Check for AutoCAD Entities on Plans 
Do you desire to look at a floor plan developed in AutoCAD 
Architecture and be able to quickly discern what are actual AEC 
objects and what are just basic AutoCAD entities?  You can go to 
the Home tab, then Inquiry panel and select the Show AutoCAD 
Entities command.  This command will temporarily hide all of the AEC objects.  
 

31. Visual Check for Tag Attachment 
There are times when “intelligent” door, window, and other tags get copied 
around a drawing instead of ACA objects being tagged individually.  This can 
make tags contain erroneous information as it might be displaying information 
for an object other than the one adjacent to the tag.  To visually check to see 
what tag is connected to what object, select the Diagnostic display 
configuration in the drawing status bar.  
 

32. Content Browser Number of Rows 
You can have the Content Browser display more than 5 rows of 
information per page which allows you to see more than 10 items 
per page.  On the first page of the Content Browser, pick the icon 
in the far lower left corner that says “Click to modify Content 
Browser preferences” when you place your mouse over it.  Change 
the default number of “5” to any number from “5” to “100” then 
select the OK button.  
 

33. Change Display Configuration with Scale 
It is very typical to have specific Display Configurations used 
for specific drawing scales.  This is now possible on the Scale 
tab of the Drawing Setup dialog box.  Select the scale, then 
select the desired Display Configuration to use for that scale.  
This can be done for each scale.  
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34. Show Clerestory Windows 

To show clerestory or other windows higher than the cut plane in a floor 
plan, change the cut plane of the wall which contains the windows.  
Highlight the wall and go to the Display tab on the Properties palette.  In 
the Object Display Properties section, change the “Override cut plane” 
option from No to Yes and change your cut plane height to go through the 
window.  You may need to break the wall into sections if you have other 
windows in the same wall.  
 

35. Mass Insertion of Door Tags 
When placing door tags (or other ACA object tags), it is possible to place tags for all doors in the 
drawing file in one operation.  Select the desired door tag from a palette or Content Browser.  At 
the “Select object to tag:” prompt, select a door to receive the tag.  At the “Specify location of 
tag <Centered>:” prompt, pick a location for the tag at that door.  The location chosen for this 
tag relative to the door is important as the remaining tags placed during this operation will use 
this relationship for their placement.  At the “Select object to tag [Multiple]:” prompt, type “M” for 
Multiple.  At the “Select objects to tag:” prompt, select the remaining doors in the drawing file.   
 

36. Mass Rotation of Door Tags 
You can rotate many tags at one time without using the Rotate command.  Highlight the desired 
tags, then go to the Properties palette.  Select the Anchor option on the Design tab.  In the 
Rotation Angle box, enter the new angle for the tags. 
 

37. Place Option Door Without Cutting Wall 
There are times when an optional door needs to be shown, but you don’t 
want to cut an opening out of the wall.    Select the desired door from a 
palette, or initiate the DoorAdd command and select the desired door 
from the Properties palette.  At the “Select wall, grid assembly or Enter:” 
prompt, press the Enter key instead of actually selecting a wall.  At the 
“Insert point:” prompt, pick an insertion point and then the rotation for the 
door.  Note that the door is not actually associated with the wall.  
 

38. Set Door to Automatically be Placed on Demo Layer 
When placing a demolished door in the drawing, it is nice to have it automatically go to the A-
Door-Demo layer (other any other layer name).  Place the desired door style on a custom 
palette as a tool.  Right-click on the door tool and select Properties… from the context menu.  
Pick inside the box to the right of Layer Overrides.  In the Select Layer Overrides dialog box, 
remove the checkmark next to “Do not specify Layer Overrides”.  Pick inside the box to the right 
of Minor 1 and below Override, and type Demo.  Pick OK to exit the dialog boxes. 
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39. Set the 3D View for Palette Tools Images 
If you add tools to your tool palette, you can specify the desired view 
direction for a tool image. Highlight the tool on the palette, right-click, and 
select Properties from the context menu.  In the Tool Properties dialog 
box, scroll down to the Viewer section.  Either use the Viewcube or pan 
the view to see the item in the direction that you desire.  Right-click over 
the image icon above the viewer and select the Refresh Image option 
from the context menu.  Pick the OK button.  
 
 

40. Add commands to a palette with the CUI 
AutoCAD Architecture commands can quickly be added to a tool palette.  Right-click on the tool 
palette’s title bar and select Customize Commands from the context menu.  Select the desired 
command and drag it to a palette. 
 

41. Create Schedule that Ignores Demolished Doors 
When creating a door schedule, demolished doors are typically not desired in the door 
schedules.  To exclude demo doors from the schedule, highlight the schedule, right-click and 
select Properties.  In the box to the right of Layer wildcard, type ~*Demo.  (That is tilde, then 
asterisk, then Demo).  This is based upon doors being placed on a layer with a Demo suffix. 
 

42. Add All Property Sets to Doors at Once 
When door schedules show question marks in the schedule, it means that doors do not have all 
of their property sets attached to the doors.  Highlight the schedule, right-click and select Add 
All Property Sets from the context menu.  This will add all property sets to the doors at once. 
 

43. Break Multiple Walls with One Door 
One door can break multiple adjacent walls.  Highlight the wall(s) 
adjacent to the wall with the door, right-click, and select Interference 
Condition, then Add from the pop-up menu (as shown below).  When 
prompted to Select AEC objects to add:, pick the desired door (or other 
allowable object) and press the ENTER key.  When prompted to Enter shrinkwrap plan effect 
[Additive/Subtractive/Ignore]:, type S for Subtractive. 
 

44. Reposition Door Along a Wall 
After a door (or window, opening, or assembly) is placed in 
a wall, it is often desirable to reposition that door to be a 
specific distance from a corner or other point.  Highlight the 
door, right-click, and select Reposition Along Wall from 
the context menu.  At the “Select position on the opening:” 
prompt, pick any point toward the right jamb, center, or left jamb of the door.  At the “Select a 
reference point” prompt, pick the point from which you desire to set the distance to the door.  At 
the “Enter the new distance between the selected points:” prompt, type in the desired distance 
from the two points you just selected.  (Note that if Dynamic Input is turned off, you must pick 2 
points to specify the distance instead of typing the distance.)  
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45. Reposition Door Within a Wall 
When a door (or window, opening, or assembly) is placed in a wall, it is 
automatically centered in the wall so it is often desirable to reposition 
that door within the wall.  Highlight the door, right-click, and select 
Reposition Within Wall from the context menu.  At the “Select position 
on the opening:” prompt, pick any point toward the interior face, center, 
or exterior face of the door frame.  At the “Select a reference point” 
prompt, pick the point from which you desire to set the distance to the door frame.  At the “Enter 
the new distance between the selected points:” prompt, type in the desired distance from the 
two points you just selected.  (Note that if Dynamic Input is turned off, you must pick 2 points to 
specify the distance instead of typing the distance.)  
 

46. Don’t Copy an AEC Object Anymore 
The reason I say not to copy is that there is a better way.  If you highlight an AEC object and 
right-click on your mouse, you get a context menu that has an option 2/3 down entitled “Add 
Selected”.  This option allows you to start adding items exactly like what you have selected.  
This is better than copy as it allows you to do more than just copy.  If you copy a wall, you need 
to rotate and resize the wall, whereas the Add Selected option takes you into the WallAdd 
command which allows you to continuously draw walls using the same parameters as the 
selected wall.  Using this command on a door or window allows you to get the dynamic input 
dimensions on either side of the door or window to accurately place the object in the wall, which 
the Copy command does not do.  Using it on a door or window also keeps the same offset 
settings of the object’s position within the wall. 
 

47. Change Standard Door Sizes Listed in Properties 
When you highlight a door and go to the Properties palette to change the size of the door, there 
are some standard door sizes listed from which you can choose.  This list may not be consistent 
with the typical door sizes which you use, but the list can be modified to reflect the typical sizes 
which you use for that particular door style.  Highlight the door, right-click and select Edit Door 
Style from the context menu.  In the Door Style Properties dialog box, go to the Standard 
Sizes tab and remove or add sizes to display the desired sizes that will appear in the 
Properties palette.  If you have a width or height highlighted when picking the “Add new 
standard size” button, the new door will have that highlighted size shown as a default for the 
new door.  
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48. Multiple Cleanup Groups to Assist with Wall Cleanups 
Placing walls in Cleanup Groups based upon usage will keep 
walls from attempting to clean up with walls of other usages 
and help alleviate some problems with wall cleanup, in 
addition to speeding up ACA.  Create separate cleanup 
groups for usages such as typical walls, cabinets, counters, 
shelving, and low walls. To create additional Cleanup Groups, 
go to Manage and select Style Manager.  Expand Architectural Objects and select Wall 
Cleanup Group Definitions in the left pane.  In the right pane, right-click and select New from 
the context menu, then enter the desired group name. 
 

49. Wall Cleanup between Xrefs 
Walls can clean up together when they are in different drawing files and xreferenced together.  
In each drawing, go to the Manage tab (in 2010) and select Style Manager.  Expand the 
Architectural Options in the left pane, then select Wall Cleanup Group Definitions.  In the 
right pane, double-click on a cleanup group to edit it and go to the Design Rules tab.  Place a 
checkmark next to the “Allow cleanup between host and xref drawings” option. 
 
 
 
 
 
 
 
 

50. Move Toilet with Adjacent Wall 
It is desirable to have a toilet or other object move automatically 
when the adjacent wall moves.  Type ObjectAnchorAttach at the 
command line.  At the “Select objects to be anchored:” prompt, 
select all of the AEC objects that you want to move with another 
AEC object and press Enter.  At the “Select an object to anchor to:” 
prompt, select the AEC object that will be the controlling object.  Whenever the controlling object 
is moved, any anchored objects will move with it.  This command can be found as the Object 
Anchor tool in the Parametric Layout & Anchoring Tools category in the Stock Tool Catalog 
in the Content Browser.  
 

51. Visual Check of AEC Object Attachments 
When toilets and other AEC objects have been attached to other AEC objects, it is 
nice to know what might be attached.  To visually check to see what AEC object is 
connected to another AEC object, select the objects in question and any connected 
objects will show a dashed line between the objects.  
 
 
 
 
 


